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ენის ელექტრონული დოკუმენტირება 

 
მატერიალური და სულიერი მემკვიდრეობის დიგიტალუ-

რი დოკუმენტირება და არქივირება კულტურული მემკვიდრეო-
ბის კვლევის აუცილებელ წინაპირობას წარმოადგენს XXI საუკუ-
ნეში. განსაკუთრებით მნიშვნელოვანია საზღვარგარეთ არსებუ-
ლი ქართული დიალექტების თანამედროვე მეთოდოლოგიის 
გამოყენებით დოკუმენტირება და არქივირება, ვინაიდან თურ-
ქეთში, ირანსა და აზერბაიჯანში ქართული მატერიალური და სუ-
ლიერი კულტურის არსებობის შემთხვევაში მათი დაცვისა და 
გადარჩენისათვის საქართველოს არ აქვს სხვა ქმედითი მექანიზ-
მები.  

დიგიტალური ჰუმანიტარიის განვითარებამ და ენათა და 
კულტურათა ელექტრონული დოკუმენტირების საშუალებების 
გაჩენამ სრულიად ახალი პარადიგმა შექმნა ჰუმანიტარულ მეცნი-
ერებაში. ცხადად გამოიკვეთა, რომ მეცნიერება XXI საუკუნეში 
უახლესი ტექნოლოგიური საშუალებებით მოპოვებული ინტერ-
დისციპლინური კვლევის რესურსების შექმნას მოითხოვს, ვინაი-
დან  

1)  თანამედროვე მეცნიერება ძირითადად ინტერდისციპ-
ლინური დარგების გაჩენის გზით ვითარდება და შესაბა-
მისად, კვლევებიც ინტერდისციპლინურ რესურსებზეა 
ორიენტირებული;  

2)  რესურსების დამუშავების დროს თანამედროვე მეცნიე-
რება კვლევის დიგიტალურ ინსტრუმენტებს იყენებს, 
რაც თავისთავად გულისხმობს კვლევის რესურსების 
დიგიტალური ფორმატის უპირატესობას. კვლევის პრო-
ცესში დიგიტალური რესურსების დიგიტალური ინ-
სტრუმენტებით დამუშავებას დღეს ალტერნატივა არა 
აქვს.  
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დიგიტალური ტექნოლოგიების სწრაფმა განვითარებამ ახა-
ლი ამოცანების წინაშე დააყენა ჰუმანიტარული მეცნიერებები. ხე-
ლახლა დაისვა კითხვა: 

1. რრა არის დღეს ჰუმანიტარული მეცნიერების ცალკეული 
დარგის კვლევის ობიექტი? ანუ ჩვენს შემთხვევაში რა არის ენისა 
და კულტურის კვლევის მიზანი? რის დოკუმენტირებას ვცდი-
ლობთ? ან რა არის ჩვენი კვლევის ობიექტი – ენა, როგორც ნიშან-
თა სისტემა (ლინგვისტური ასპექტი), ენა, როგორც ლინგვოკულ-
ტურული კონცეპტების ნაკრები (ლინგვოკულტუროლოგიური 
ასპექტი) თუ ენა, როგორც მის ბუნებრივ მოცემულობაში - კონ-
კრეტულ დროში, კონკრეტულ სივრცესა და კონკრეტულ სოცია-
ლურ გარემოში ფუნქციონირებადი მექანიზმი? 

2. როგორ მოვიპოვოთ და შევინახოთ რესურსები ციფრუ-
ლი მეცნიერების საუკუნეში? რა მეთოდები უნდა გამოვიყენოთ 
რესურსების მოპოვების დროს, რათა შესაძლებელი გახდეს სხვა-
დასხვა დისციპლინის ფარგლებში მათი ფართო გამოყენება  (ინ-
ტერდისციპლინურობა) და შენახვა (მდგრადობა), ანუ დიგიტა-
ლურად დამუშავება და საიმედოდ დაცვა მომავალი კვლევის-
თვის. 

საკითხის ამგვარად დასმამ ბიძგი მისცა ენათა და კულტუ-
რათა დოკუმენტირების შემდგომ განვითარებას და, რაც მთავა-
რია, ცნება დოკუმენტირების რეინტერპრეტაციას. 

 
1. რა არის დოკუმენტირება? 

 
დოკუმენტირება განისაზღვრება, როგორც პროცესი, 

რომლის დროსაც ხდება ფაქტებისა და მოვლენების შეკრება, 
სორტირება და კლასიფიცირება.   დოკუმენტირების, როგორც 
ცნების, ენასა და კულტურასთან მიმართებით განსაზღვრა, ერ-
თი შეხედვით, ემთხვევა ენისა და კულტურის აღწერას (დეს-
კრიფციას). თუმცა ენებისა და კულტურების კვლევის თანამედ-
როვე მეთოდების განვითარებამ არსებითად შეცვალა დოკუმენ-
ტირების, როგორც ცნების შინაარსი.       
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იმთავითვე უნდა აღინიშნოს, რომ დდოკუმენტირება არ არის  
მასალის უბრალო ჩაწერა-ფიქსაცია. ამ ცნებამ თანამედროვე ენათ-
მეცნიერებაში უფრო ფართო და მრავალწახნაგოვანი შინაარსი შე-
იძინა. XXI საუკუნის გამოწვევების შესაბამისად ხელახლა დამუ-
შავდა დოკუმენტირების ძირითადი პრინციპები და მეთოდები, 
რამაც საფუძველი ჩაუყარა ენებისა და კულტურების დოკუმენ-
ტირების თვისობრივად ახალ ეტაპს – დიგიტალურ დოკუმენტი-
რებასა და არქივირებას. 

ჯერ კიდევ გასული საუკუნის 90-იან წლებში, როდესაც ამე-
რიკის შეერთებული შტატების 200 წლისთავისათვის მიმდინარე-
ობდა მზადება, სამეცნიერო წრეებში დაისვა საკითხი: რა მოუტანა 
ამერიკის კონტინენტის ადგილობრივ მოსახლეობას ევროპელთა 
კოლონიური პოლიტიკის შედეგად წარმოქმნილმა მულტიეთნი-
კურმა კონგლომერატმა – ამერიკის შეერთებულმა შტატებმა? მი-
უხედავად აზრთა სხვადასხვაობისა, მეცნიერების ერთსულოვნე-
ბა ერთ საკითხში ცხადად გამოიკვეთა: ბოლო 200 წლის განმავ-
ლობაში საგრძნობლად შემცირდა ინდიგენური მოსახლეობის რი-
ცხვი, გაქრა მრავალი ენა და მათთან ერთად კულტურაც ისე, რომ 
ზოგიერთის შესახებ მწირი ცნობებიც კი არ დარჩენილა. ამ სავა-
ლალო შეფასებამ საგონებელში ჩააგდო თანამედროვე მეცნიერება 
და დღის წესრიგში დააყენა ენებისა და კულტურების მულტი-
დისციპლინული ანალიზის საჭიროება. კვლევის მთავარ მიზნად 
იქცა იმის დადგენა, თუ რა მდგომარეობაში იმყოფებიან ინდიგე-
ნური უმცირესობის ენები (და არა მარტო უმცირესობის), ემუქრე-
ბათ თუ არა მათ გაქრობის საფრთხე. 

პირველი სამეცნიერო სემინარი თემაზე „საფრთხეში მყოფი 
ენები“ 1993 წელს ჩატარდა გერმანიაში. საკითხის მრავალმხრივმა 
და ღრმა ანალიზმა ენათა დოკუმენტირების სრულიად ახალი 
პერსპექტივები წარმოაჩინა.       

მეცნიერების განვითარების ფონდი Volkswagen Stiftung-ი 
XXI საუკუნეს ახალი ინიციატივით შეხვდა – შეიმუშავა სამეცნიე-
რო კვლევითი პროგრამის DOBES1 (Sokumentation der bedrohten 

 
1 http://dobes.mpi.nl/ 
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Sprachen) კონცეფცია, რომელიც მიზნად ისახავდა საფრთხეში 
მყოფი ენების დოკუმენტირებას მათი არქივირებისა და შესაძლო 
რევიტალიზაციის მიზნით. 1999-2011 წლებში პროგრამის ფარ-
გლებში სულ 67 სამეცნიერო პროექტი განხორციელდა მსოფლიოს 
ხუთივე კონტინენტზე, რომელთა კვლევის შედეგად დამუშავდა 
დიგიტალური დოკუმენტირებისა და არქივირების დღეისათვის 
მოქმედი საერთაშორისო სტანდარტი. 

 

 
 

სურ.1.. Dobes-ის პროგრამის ვებგვერდი 
 
პროგრამის ფარგლებში დამუშავდა ენებისა და კულტუ-

რების დოკუმენტირების ახალი სტრატეგია, შემუშავდა ძირითა-
დი პრინციპები და მეთოდოლოგია და, რაც მთავარია, შეიქმნა 
დიგიტალური რესურსების დამუშავებისა და არქივირების ტექ-
ნოლოგიური ინსტრუმენტები. პროგრამის ფარგლებში მოპოვე-
ბული რესურსების არქივირებისათვის ნეიმეხენის მაქს პლანკის 
ინსტიტუტში (ჰოლანდია) შეიქმნა ენათა არქივი TTLA (The 
Language Archive), სადაც თავმოყრილია DOBES-ის ფარგლებში 
მოპოვებული მასალები. 

ერთი მხრივ, ენათა და კულტურათა დიგიტალური დო-
კუმენტირებისა და არქივირების თეორიული საფუძვლებისა და 
მეთოდოლოგიის დამუშავებამ და მეორე მხრივ,  ტექნოლოგიუ-
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რი ინსტრუმენტების განვითარებამ ხელი შეუწყო დიგიტალუ-
რი ჰუმანიტარიის ფარგლებში ახალი დისციპლინის – დდოკუ-
ლინგვისტიკის ჩამოყალიბებას. მეცნიერების ამ ახლად განვი-
თარებულ დარგს დღეისათვის საკუთარი თეორიული ბაზისი 
(დიგიტალური დოკუმენტირებისა და არქივირების ძირითადი 
პრინციპები და მეთოდები) და საკუთარი პროგრამული უზრუნ-
ველყოფა გააჩნია – რესურსების მოპოვების (მასალის ჩაწერის), 
აღრიცხვის (რეგისტრაციის), ტექნიკური დამუშავების (დიგიტა-
ლიზაციის), შენახვის (არქივირების) და შემდგომი მოვლის 
(დაცვის) მეთოდოლოგიური და ტექნოლოგიური საშუალებები. 

 
 

2. ენის დოკუმენტირების ძირითადი მიზნები 
და ამოცანები 

 
ენის დოკუმენტირების ახალი სტრატეგიის შემუშავების 

აუცილებლობა რამდენიმე ფაქტორით იყო განპირობებული: 
1. ენათა გაქრობის მზარდი პროცესით; 
2. ენის ინტერდისციპლინური კვლევის აუცილებლო-

ბით; 
3. დიგიტალური რევოლუციით; 
4. ენათა დოკუმენტირების ახალი კონცეფციით, რო-

მელმაც სათავე დაუდო ლინგვისტიკის ახალი მიმარ-
თულების – „დოკულინგვისტიკის“ შექმნას2; 

ენათა გაქრობის საშიშროების გაცნობიერებამ ცხადი გახა-
და, რომ ენის გაქრობასთან ერთად ქრება ამ ენის მატარებელი სო-
ციუმის კულტურული მემკვიდრეობა, ქრება სოციუმის შემოქმე-
დებითი პოტენციალის რეალიზების შესაძლებლობა. საკითხის ამ 
კუთხით განხილვამ წინა პლანზე წამოსწია არა მხოლოდ ენის, 
როგორც ნიშანთა სისტემის, არამედ ენისა და კულტურის ინტერ-
დისციპლინული დოკუმენტირების აუცილებლობა. დიგიტალუ-
რი რესურსების შექმნისა და მათი ავტომატური გადამუშავების 

 
2 N. Himmelmann, Documentary and descriptive linguistics, Linguistics 36 (1998). 
161-195. 
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ტექნოლოგიების განვითარებამ სრულიად შეცვალა ენობრივი რე-
სურსების მოპოვების, სტრუქტურირებისა და შენახვის შესაძლებ-
ლობები. 

დდოკულინგვისტიკის ერთ-ერთი დამფუძნებელი ნ. ჰიმელ-
მანი არ კმაყოფილდება ენის ტრადიციული დოკუმენტირების 
სტანდარტით: ცნობილი ენათმეცნიერისა და ანთროპოლოგის – 
ფრანც ბოასის (Franz Boas) მიერ შემუშავებული ტრიადა – გრამა-
ტიკა, ლექსიკონი, ტექსტი – იცვლება ანოტირებული ელექტრო-
ნული კორპუსების შექმნითა და ენობრივი რესურსების დამუშა-
ვების   მულტიმედიური ფორმატის განვითარებით. ნ. ჰიმელმა-
ნის მიხედვით, ენის დოკუმენტირება ნიშნავს ენობრივ მონაცემთა 
თანმიმდევრულ და მრავალმიზნობრივ (ინტერდისციპლინური 
კვლევებისათვის გათვლილ) შეგროვება-დაფიქსირებას, მოპოვე-
ბული რესურსების ტექნოლოგიურ დამუშავებას და მათ არქივი-
რებას. 

ენათა თანამედროვე დოკუმენტირება არსებითად  გან-
სხვავდება დესკრიფციისაგან. იგი მიზნად ისახავს არა მხოლოდ 
ენის, როგორც ნიშანთა სისტემის, კვლევას და აღწერას, არამედ კა-
ცობრიობის სულიერი მემკვიდრეობის დოკუმენტირებასაც, კერ-
ძოდ: 

1. კულტურული მემკვიდრეობის შენახვას და გადაცე-
მას ამ ენის მატარებელი სოციუმის მომდევნო თაო-
ბებისათვის; 

2. ყოვლისმომცველი და სრულფასოვანი  მასალის შე-
კრებას ემპირიული კვლევებისათვის; 

3. მოპოვებული მასალების ინტერდისციპლინული 
კვლევებისათვის გამოყენების შესაძლებლობის შე-
ქმნას; 

4. საფრთხეში მყოფი ენის გადარჩენის ხელშეწყობას.               
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33. ენის დოკუმენტირების ძირითადი პრიციპები 
 
დიგიტალური დოკუმენტირება და არქივირება 

ხორციელდება დოკულინგვისტიკის ფარგლებში საგანგებოდ 
შემუშავებულ პრინციპებზე დაყრდნობით და მოიცავს შემდეგ 
აუცილებელ კომპონენტებს:  

 
I. საველე ექსპედიციის (Fieldwork) კონცეპტუალიზაცია და 

პრაქტიკული განხორციელება 
 

სამეცნიერო ექსპედიციის ჩატარებამდე აუცილებელია ექ-
სპედიციის კონცეპტუალური დაგეგმვა: 

1. ექსპედიციის გეგმა-გრაფიკის შემუშავება;  
2. ექსპედიციის პრაქტიკული განხორციელების ოპტი-

მიზება ისეთი რისკფაქტორების გათვალისწინებით, 
როგორებიცაა, მაგალითად, სახელმწიფო-პოლიტი-
კური, კლიმატური, რელიგიური ფაქტორები, საომა-
რი მოქმედების ზონა, საზოგადოების სოციალური 
სტრუქტურა და ა. შ.; 

მასალების საველე პირობებში მოპოვების პროცესში აუცი-
ლებელია დოკულინგვისტიკის ძირითადი პრინციპების გათვა-
ლისწინება, კერძოდ: 

1. მასალის მოპოვება ენობრივი კომპეტენციის განსხვა-
ვებული საფეხურების შესაბამისად;  

2. ენის/დიალექტის გამოყენების სფეროების დადგენა 
ბილინგვიზმის პირობებში;  

3. კოდების ცვლისა და ენის/დიალექტის საფრთხეში 
ყოფნის ინდიკატორების დადგენა;  

4. ასაკობრივი ცენზისა და  გენდერული ბალანსის და-
ცვა;  

5. თემატურად მრავალფეროვანი მასალის მოპოვება. 

  თემატური მასალების მოპოვების დროს აუცილებელია 
ინტერვიუების ბუნებრივ პირობებში ჩაწერა. მაგ., ვაზის კულტუ-
რის შესახებ ინტერვიუ სასურველია, ყურძნის მოსავლის აღების 



10 
 

დროს დაიგეგმოს, რელიგიური და რიტუალური თემების შესახებ 
ინტერვიუები პროცედურული ან სადღესასწაულო რიტუალების 
დროს უნდა ჩაიწეროს. 
 დოკუმენტაციის დროს გამოიყენება როგორც ოობსერვაცი-
ის (სიტუაციებზე და მოვლენებზე დაკვირვების), ისე ელიციტა-
ციის (ინფორმანტების მიზნობრივი გამოკითხვის) მეთოდი. 

მასალის გადაღების პროცესში გასათვალისწინებელია ტექ-
ნიკური პარამეტრების დაცვა:  

1. გადაღების ობიექტის განსაზღვრა;  
2. კადრების მონაცვლეობის აუცილებლობის განსა-

ზღვრა;  
3. გამოსახულების ოპტიმიზება;  
4. გადაღების ხედის ცვლა.  

დოკუმენტირების პროცესში გადაღებული ვიდეომასა-
ლა არ არის მხატვრული ან დოკუმენტური ფილმისათვის გან-
კუთვნილი, ამიტომ სასურველია კადრების ცვლილების სიხში-
რე მინიმუმამდე შეამციროთ. 

 
II. საველე ექსპედიციაში მოპოვებული ენობრივი  
მასალების ელექტრონული დამუშავების ეტაპები  

ვიდეომასალების მოპოვების შემდეგ მასალების ელექ-
ტრონული დამუშავების რამდენიმე ეტაპია გასავლელი:  

1. ვიდეოების თემატური დახარისხება;   
2. დახარისხებული მასალის წინადადებებად სეგმენტირე-

ბა;  
3. წინადადებებად სეგმენტირებული ზეპირმეტყველების 

ტრანსკრიბირება;  
4. ტრანსკრიბირებული ტექსტის გლოსირება და ინგლისუ-

რად თარგმნა.   
განვიხილოთ თითეული ეტაპი ცალ-ცალკე.  
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33. საველე ექსპედიციაში მოპოვებული ენობრივი  
მასალების ელექტრონული დამუშავება  

 
3.1. ვიდეომასალების ლაბორატორიული დამუშავების 

პირველი ეტაპი  
ა) ვიდეომასალის თემატური დახარისხება 

 
ვიდეომასალის მოპოვების შემდეგ უნდა დაახარისხოთ 

გადაღებული ვიდეო. ამისათვის ხელახლა უნდა მოისმინოთ ვი-
დეოჩანაწერი და შეიმუშაოთ კონცეფცია, თუ რომელ თემატურ 
ფრაგმენტებად გსურთ მოცემული ვიდეოს დანაწევრება.  

ამ ოპერაციის განხორციელება შესაძლებელია სხვადასხვა 
პროგრამით, რომლებიც, როგორც წესი, ღია რესურსს წარმოად-
გენს და შესაძლებელია მისი ინტერნეტის მეშვეობით გადმოწერა. 
გაითვალისწინეთ, რომ ამგვარი საყოველთაო მოხმარების პროგ-
რამები ძალიან სწრაფად იხვეწება და სამომხმარებლო ბაზარი 
სულ უფრო მეტად არის გაჯერებული ახალი პროდუქტებით. მო-
ცემული პროექტის ფარგლებში ჩვენ გამოვიყენეთ ვიდეოფაილე-
ბის დაჭრის ერთ-ერთი პროგრამა  Any Video Converter 
(https://www.any-video-converter.com/).  

ქვემოთ მოცემულია ამ პროგრამის გამოყენების წესები.  
 
1. გადმოწერეთ აღნიშნული პროგრამა თქვენს კომპიუ-

ტერში. ამისათვის გამოიყენეთ შემდეგი ბმული 
https://www.any-video-converter.com/products/ 

for_video_free/. გაითვალისწინეთ, რომ  დროთა განმავ-
ლობაში შესაძლოა ბმული შეიცვალოს და პროგრამის 
შეუფერხებლად გადმოსაწერად სასურველია, გქონ-
დეთ უწყვეტი და სწრაფი ინტერნეტი.  
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სურ.2. Any Video Converter-ის მთავარი ფანჯარა 
 

2. გამოიძახეთ ის ვიდეოფაილი, რომლის დანაწევრება-
საც აპირებთ. ამისათვის დააჭირეთ ღილაკს წარწერით 
Add or Drag File(s), საქაღალდეების ჩამონათვალში მო-
ძებნეთ საჭირო ფაილი და გახსენით.  

 
სურ.3. Any Video Converter-ში ვიდეოფაილის გახსნა 
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3. ფაილის დასაჭრელად დააჭირეთ ღილაკს მაკრატლის 
ნიშნით (Clip this item). ამ ოპერაციის შედეგად გააქტი-
ურდება გადმოწერილი  ვიდეოფაილი. 

 

 
სურ.4. Any Video Converter-ში დაჭრის ფუნქციის არჩევა 

 
4. გახსენით ვიდეო და მონიშნეთ თემატური ფრაგმენ-

ტის საწყისი: დააყენეთ კურსორი ამოსაჭრელი ფრაგ-
მენტის დასაწყისში და დააჭირეთ ღილაკს start point.  

 
სურ.5. Any Video Converter-ში ფრაგმენტის მონიშვნა 
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შედეგად ფრაგმენტის დასაწყისში და ხილული ველის ბო-
ლოში გამოჩნდება შავი სამკუთხა ნიშანი. გადმოწიეთ ეს უკანას-
კნელი იმ ადგილამდე, სადაც გინდათ, რომ დასრულდეს ფრაგ-
მენტი. შემდეგი ფრაგმენტის ამოსაჭრელად უნდა გაააქტიუროთ 
ღილაკი New Segment. დააყენეთ მარცხენა შავი კურსორი ამოსაჭ-
რელი ფრაგმენტის დასაწყისზე და მარჯვენა შავი კურსორი - ამო-
საჭრელი  ფრაგმენტის დასასრულზე. ქვედა ველში პირველი სეგ-
მენტის ქვემოთ მოექცევა მეორე სეგმენტი. 

 
სურ.6. Any Video Converter-ში არჩეული სეგმენტების სია 

 
ეს ოპერაცია უნდა გაიმეოროთ იმდენჯერ, რამდენი ფრაგ-

მენტის ამოჭრაც გაქვთ დაგეგმილი. გაითვალისწინეთ, რომ სა-
სურველია ვიდეომასალები წინასწარ მოისმინოთ და წინასწარ შე-
იმუშაოთ კონცეფცია, თუ რამდენ თემატურ ფრაგმენტად გსურთ 
აღნიშნული ფაილის დანაწევრება. 

ვიდეოფაილის ამგვარად დამუშავების შემდეგ შეგიძლიათ 
დაასრულოთ ეს ოპერაცია. ამისათვის დააჭირეთ ღილაკს OK. 
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სურ.7. Any Video Converter-ში ვიდეო ფაილის ფრაგმენტების მონიშვნის  

დასრულება 
ზემოთ აღწერილი ოპერაციის შედეგად შეიქმნება ამოჭრილ 

ფრაგმენტთა სია.  

 
სურ.8. Any Video Converter-ში საწყისი ფაილი და დამუშავებისათვის გამზა-

დებული სეგმენტების სია 
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თუ გსურთ  ფაილების ოპტიმიზაცია ზომის თვალსაზრი-
სით, სამუშაო არეალის მარჯვენა ნაწილში, სადაც მოთავსებულია 
ვიდეოფაილის მიმდინარე თვისებების ჩამონათვალი Basic 

Settings, აირჩიეთ ღილაკი Video size, რაც საშუალებას მოგცემთ 
მართოთ გამოსახულების ზომა. 

 
სურ.9. Any Video Converter-ში ცალკეული სეგმენტისათვის გამოსახულების 

ზომის შერჩევა 

ხოლო თუ გსურთ ფაილის ხარისხის შეცვლა, გამოიყენეთ 
ღილაკი Quality:     

 
სურ.10. Any Video Converter-ში ცალკეული სეგმენტისათვის გამოსახულების 

ხარისხის მართვა 
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5. პარამეტრების დაყენების შემდეგ მონიშნეთ ის ფრაგ-
მენტები, რომლის კონვერტაციასაც აპირებთ.  

 

 
სურ. 11. Any Video Converter-ში კონვერტაციისათვის გამზადებული სეგმენ-

ტების ამორჩევა 

 
6. ვინაიდან ფაილები თემატურადაა დაჭრილი და სხვა-

დასხვა საქაღალდეში უნდა შეინახოთ, საჭიროა კონ-
ვერტაციის წინ ამოირჩიოთ საქაღალდე, რომელშიც 
გსურთ მათი დამახსოვრება. ამისათვის Basic Settings-
ის მეშვეობით უნდა მიუთითოთ კონვერტირებული 
ფაილების შესანახი ადგილი.  
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სურ.12. Any Video Converter-ში სეგმენტების შენახვისათვის განკუთვნილი 

საქაღალდეების მითითება 

 
7. ოპერაციის დასასრულებლად დააჭირეთ ღილაკს Convert 

Now! პროგრამა დაიწყებს კონვერტაციას და რამდენიმე წუთ-
ში შერჩეულ საქაღალდეებში ჩაიწერება ვიდეოფაილები, 
რომლებიც შეიცავს ჩვენ მიერ შერჩეულ ვიდეოსეგმენტებს.  

 
სურ.13. Any Video Converter-ში კონვერტაციის დაწყება 
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ამით დასრულებულია ვიდეომასალების დამუშავების პირ-
ველი ეტაპი.  

 
33.2. ტექსტის სეგმენტაცია  

პროგრამული პაკეტის ELAN-ის გამოყენებით 
 

ვიდეოფაილის დამუშავების მეორე ეტაპი არის ტექსტის გა-
შიფვრა და წინადადებებად სეგმენტირება. ამ ოპერაციის განხორ-
ციელება ყველაზე მოსახერხებელია ELAN პროგრამული პაკეტის 
მეშვეობით, რომლის შედეგადაც იქმნება ფაილის საგანგებო 
ფორმატი EAF (ELAN Annotation Format – http://www.file-

extension.org/de/extensions/eaf). შეგახსენებთ, რომ ფაილის 
აღნიშნული ფორმატის კონცეფცია ნეიმეხენის მაქს-პლანკის ინ-
სტიტუტში შემუშავდა DOBES-ის პროგრამის ფარგლებში. 

ELAN-ი ღია რესურსია და საშუალებას იძლევა ვიდეო- და 
ტექსტური რესურსები ერთ ფაილში მოექცეს. ეს პროცესი რამდე-
ნიმე ეტაპად ხორციელდება.  

1. უპირველეს ყოვლისა, ჩამოტვირთეთ პროგრამა ELAN-ი 
და დააინსტალირეთ კომპიუტერში. ამ პაკეტის ჩამო-
ტვირთვა შეგიძლიათ შემდეგი მისამართიდან 
https://tla.mpi.nl/tools/tla-tools/elan/download/, ხოლო სრულ 
დოკუმენტაციას კი გაეცნობით ამ მისამართზე:    

2. https:// www.mpi.nl/corpus/html/elan/index.html.  
3. გახსენით ELAN-ის პროგრამა და შექმენით ახალი პროექ-

ტი - EAF (ELAN Annotation Format3) ფაილი, რომელიც 
აკავშირებს ტექსტსა და აუდიო/ვიდეო ფაილებს. ამისა-
თვის მთავარ მენიუში აირჩიეთ შემდეგი პუნქტი: File > 

New...  

 
3 http://www.file-extension.org/de/extensions/eaf 
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სურ.14. ELAN-ში ახალი პროექტის შექმნა 

 
4. გამონათებული ფანჯრის მარცხენა მხარეს განლაგებული 

ნავიგაციის ღილაკებით გახსენით საქაღალდე  და  ამოირ-
ჩიეთ სასურველი ვიდეოფაილი, მონიშნეთ ვიდეო და ღი-
ლაკით >> მისი სახელი შევა ფანჯრის მარჯვენა ნაწილში 
მოთავსებულ პროექტისათვის შერჩეულ ფაილების სიაში  
(Selected Files). არჩევანი დაადასტურეთ ღილაკით OK. გა-
ითვალისწინეთ, რომ ერთ პროექტში შესაძლოა რამდენი-
მე ვიდეოფაილი შედიოდეს. 

 
სურ.15. ELAN-ში პროექტისათვის ვიდეოფაილების შერჩევა 
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5. კურსორი მიიტანეთ ვიდეოგამოსახულების ქვედა ნაწილ-
ში განთავსებულ  ღილაკთან და მისი მეშვეობით დაა-
პატარავეთ ვიდეოგამოსახულების ფანჯარა, რათა უფრო 
მეტი სივრცე დაგრჩეთ ეკრანზე პროგრამის ეფექტური 
გამოყენებისათვის.   

 
სურ.16. ELAN-ში ვიდეო გამოსახულების ფანჯრის ზომების მართვა 

 
6. ვიდეოფაილის სტრუქტურირებისთვის საჭიროა რამდე-

ნიმე ველის (tier) შექმნა:  
1. transkription-txt.kat – აღნიშნული ველი განკუთვნი-

ლია წინადადების ტრანსკრიფციისათვის;   
2. Translation-gls.en – აღნიშნული ველი განკუთვნი-

ლია ინგლისური თარგმანისათვის; 
3. Words-txt.kat – აღნიშნული ველი განკუთვნილია 

ლემებისათვის; 
4. Participant-note.kat – აღნიშნული ველი განკუთვნი-

ლია ინფორმანტთა შესახებ დამატებითი მონაცე-
მებისათვის (გვარი, სახელი, ასაკი და ა.შ.). 
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აღნიშნული ველები, მათი სახელები, სტრუქტურა და თვი-
სებები (იხ. ქვემოთ) აუცილებელია ELAN-ში არსებული მონაცე-
მების FLEx-ში გადატანისათვის. 

სანამ ველებს (tier) შექმნით, საჭიროა თითეული ველის შე-
საბამისი ლინგვისტური ტიპების შექმნა.  

აა)) ლინგვისტური ტიპების დამატება 

ახალი ლინგვისტური ტიპის დასამატებლად აუცილებე-
ლია, მთავარ მენიუში აირჩიოთ პუნქტი: Type>Add New Tier Type. 

 
სურ.17. ELAN-ში ლინგვისტიური ტიპის დამატების ბრძანება 

 
გამონათებულ ფანჯარაში შეგიძლიათ შექმნათ იმდენი ახა-

ლი ლინგვისტური ტიპი, რამდენიც გჭირდებათ. 
transkription-txt.kat ველისთვის საჭიროა ლინგვისტური ტი-

პი phrases და შესაბამისად (იხ. სურ. 18) Type name ველში ჩაწერეთ 
phrases (1)  და დააჭერთ ღილაკს Add (2). 
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სურ.18. ELAN-ში transkription-txt.kat ველისათვის ლინგვისტური ტიპის 
შექმნა 

phrases ჩაემატება ტიპების ჩამონათვალში. 
ახლა დაამატეთ ახალი ტიპი words, რომელიც საჭიროა 

Words-txt.kat ველისთვის. შესაბამისად (იხ. სურ. 19), Type name 
ველში ჩაწერეთ  words (1), Stereotype ველში აირჩიეთ Symbolic 

Subdivision (2) და დააჭირეთ ღილაკს Add (3). 

  1 

  2 



24 
 

  
 

სურ.19. ELAN-ში Words-txt.kat ველისათვის ლინგვისტური ტიპის შექმნა 

ახლა დაამატეთ ახალი ტიპი note, რომელიც საჭიროა 
Translation-gls.en ველისთვის. შესაბამისად (იხ. სურ. 20) Type name 
ველში ჩაწერეთ note (1), Stereotype ველში აირჩიეთ Symbolic 

Association (2) და დააჭირეთ ღილაკს Add (3). 

  2 
  1 

  3 
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სურ.20. ELAN-ში Translation-gls.en ველისათვის ლინგვისტური ტიპის შექ-

მნა  
 

შემდეგი ეტაპი არის უკვე ველების (tier) შექმნა. ამისათვის 
მთავარ მენიუში აირჩიეთ: Tier>Add New Tier…  

გამონათებულ ფანჯარაში შეიტანეთ ახალი ველების თვი-
სებები. ამ ფანჯრიდან ასევე არის შესაძლებელი ველების წაშლა 
(delete), ცვლილებების შეტანა (change) და სხვა ფაილიდან ველე-
ბის გადმოტანა (import). 

 

  3 

  2 
  1 
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სურ.21 ELAN-ში Tier-ველების დამატების ბრძანების გამოძახება  

ახლა შექმენით პირველი ძირითადი ველი transkription-

txt.kat (ეს ველი განკუთვნილია წინადადების ტრანსკრიფციისა-
თვის), ამისათვის Tier name-ში ჩაწერეთ transkription-txt.kat, ხოლო 
Tier type-ში აირჩიეთ Phrases და დააჭერთ ღილაკს  Add. 

 
სურ.22. ELAN-ში transkription-txt.kat ველის Tier-ის დამატება 
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შემდეგი ველი იქნება Words-txt.kat (ეს ველი განკუთვნილია 
ლემებისათვის). Tier name-ში წერთ Words-txt.kat, Parent Tier-ში უნ-
და მიუთითოთ transkription-txt., ხოლო Tier type-ში ირჩევთ words 

და ასევე დააჭერთ ღილაკს Add. 
 

 
სურ.23. ELAN-ში Words-txt.kat ველის Tier-ის დამატება  

 
შემდეგი ველი იქნება Translation-gls.en (განკუთვნილია ინ-

გლისური თარგმანისათვის). Tier name-ში წერთ Translation-gls.en, 
Parent Tier-ში უნდა მიუთითოთ transkription-txt.kat), ხოლო Tier 

type-ში აირჩიოთ note და დააჭიროთ ღილაკს Add. 
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სურ.24. ELAN-ში Translation-gls.en ველის Tier-ის დამატება  

 
და ბოლო ველი იქნება Participant-note.kat (განკუთვნილია 

ინფორმანტთა შესახებ დამატებითი მონაცემებისათვის). Tier 

name-ში წერთ Participant-note.kat, Parent Tier-ში უნდა მიუთითოთ 
ისევ transkription-txt.kat, ხოლო Tier type-ში აირჩიოთ note და დაა-
ჭიროთ ღილაკს Add. 
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სურ.25. ELAN-ში Participant-note.kat ველის Tier-ის დამატება 

  
ამით დასრულდება ველების შექმნა, ანუ ფაილის სტრუქ-

ტურირება. შედეგად მიიღებთ ასეთ სურათს: 

 
სურ.26. ELAN-ში დამატებული Tier-ების სტრუქტურა 
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ბბ) ფაილის წინადადებებად სეგმენტირება 
 

ოპერაციის შემდეგი ეტაპი ითვალისწინებს ფაილის წინა-
დადებებად სეგმენტირებას. უპირველეს ყოვლისა, მარჯვენა კუ-
თხეში განთავსებული ზომის მაჩვენებელი კურსორით შეგიძლი-
ათ შეამციროთ ინტერვალები წუთებს შორის, რათა უკეთ გამო-
ჩნდეს ეკრანზე მოსანიშნი მასალა.   
 

 
სურ.27. ELAN-ში დროის სკალის მასშტაბის ცვლილება 

 
დააყენეთ კურსორი ფაილის დასაწყისში და  ჩართეთ ვი-

დეო. პირველი წინადადების შემდეგ კურსორი გააჩერეთ  ვიდეო-
ზე. შემდეგ დააჭირეთ კლავიშს shift, პარალელურად კურსორით 
მიდით მონიშნული მონაკვეთის დასაწყისში და ორჯერ დააწკა-
პუნეთ. შედეგად ცისფრად მოინიშნება ვიდეოს ეს აღნიშნული 
მონაკვეთი და პირველი ველი  (transkription-txt.kat) თეთრად გაიხ-
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სნება. ამის შემდეგ დააწკაპუნეთ მონაკვეთის ბოლოში და წითე-
ლი კურსორი ავტომატურად გადავა შემდეგი მონაკვეთის დასა-
წყისში. 
  

 
სურ.28. ELAN-ში ვიდეოფრაგმენტის მონიშვნის შედეგად მიღებული  

სეგმენტი  

 
კვლავ ჩართეთ ვიდეო და მომდევნო წინადადების დამთავ-

რების შემდეგ გააჩერეთ. შემდეგ დააჭირეთ კლავიშს shift და პა-
რალელურად კურსორი მიიტანეთ მონიშნული მონაკვეთის დასა-
წყისში (წინა ფრაგმენტის დასასრულთან მაქსიმალურად ახლოს) 
და ორჯერ დააწკაპუნეთ. შედეგად ცისფრად მოინიშნება ვიდეოს 
ეს აღნიშნული მონაკვეთიც და პირველი ველი  (transkription-

txt.kat) თეთრად გაიხსნება.  
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სურ.98. ELAN-ში ვიდეოფრაგმენტის მონიშვნის შედეგად მიღებული  სეგ-

მენტები   

 
ასე გააგრძელეთ მანამ, სანამ არ დაასრულებთ მოცემული 

ვიდეოს წინადადებებად სეგმენტირებას.  
წითელი ხაზის ზუსტად დაყენების მიზნით გამოიყენეთ 

ღილაკები: (+, -) ან ღილაკი F მარჯვენა ან მარცხენა მხარეს. 
 

ალტერნატივა: არსებობს სეგმენტებად დაყოფის სხვა გზაც. ამისა-
თვის მთავარ მენიუში ავირჩიოთ ბრძანება Options> Segmentation 

Mode. 

 
სურ.30. ELAN-ში ტექსტის სეგმენტირების რეჟიმის გამოძახება 
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კურსორით შეარჩიეთ transkription-txt.kat ველი და დაიწყეთ 
სეგმენტირება. სეგმენტის დასაწყისსა და ბოლოში უნდა გამოიყე-
ნოთ ღილაკი enter. შედეგად ავტომატურად გამოიყოფა სეგმენტი. 
ასე გააგრძელეთ მუშაობა მთლიანი ფაილის დასრულებამდე. 

 

 
სურ.31. ELAN-ში ტექსტის ავტომატური სეგმენტირების შედეგი 

  
იმისათვის, რომ გაგიმარტივდეთ ვიდეოფაილის მოსმენა, 

შესაძლებელია სიჩქარის შემცირება. ამისათვის აირჩიეთ controls 
მენიუ და Rate ველში შეამცირეთ სიჩქარის პროცენტულობა. 

 
სურ.32. ELAN-ში ვიდეოფაილის მოსმენის სიჩქარის მართვა 
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თუ გინდათ დაბრუნდეთ პირვანდელ რეჟიმში, მთავარ მე-
ნიუში გამოიძახეთ Option>Annotation Mode ბრძანება, სადაც ასევე 
გამოჩნდება თქვენ მიერ შექმნილი სეგმენტები. 

 

 
სურ.33. ELAN-ში ვიდეოფრაგმენტის მონიშვნის შედეგად მიღებული  

სეგმენტი  
 

ფაილის წინადადებებად სეგმენტირების შემდეგ აუცილე-
ბელია ტექსტის ტრანსკრიბირება. აღნიშნული ოპერაცია შესაძ-
ლებელია წინადადებების სეგმენტირების პარალელურად, თუმცა 
პროგრამას გააჩნია უფრო მოქნილი სტრატეგია ტრანსკრიფციის 
განსახორციელებლად: დანაწევრებული ვიდეო ავტომატურად 
გარდაიქმნება წინადადებების ვიდეორეესტრად. იმისათვის, რომ 
ტექსტის ტრანსკრიფცია ეფექტურად განახორციელოთ, მთავარ 
მენიუში გამოიძახეთ ბრძანება Option>Transcription mode. 
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სურ.34. ELAN-ში ტრანსკრიბირების რეჟიმის გამოძახება  

 
ეკრანზე  გამონათებული ფანჯრის  ველში select type for 

column აირჩიეთ Phrases და დააჭირეთ ღილაკს  apply.  
 

 
სურ.35. ELAN-ში ტრანსკრიბირების რეჟიმში ფრაზების ტრანსკრიბირების 

არჩევა 
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შედეგად შეიქმნება ველების ცხრილი, რომელშიც სტრიქო-
ნების რაოდენობა შეესაბამება წინადადებების რაოდენობას: გამო-
ვა იმდენი სტრიქონი, რამდენი წინადადებაც მონიშნეთ ფაილში. 

 
სურ.36. ELAN-ში ფრაზების ტრანსკრიბირების ფანჯარა 

თითეულ ველში დაწკაპების შედეგად ავტომატურად ჩაირ-
თვება ვიდეო და თქვენ შეძლებთ მხოლოდ წინასწარ მონიშნული 
წინადადების ვიდეოფრაგმენტის მოსმენას.  

ფრაზების რეესტრის შევსების შემდეგ შეგიძლიათ დაბრუნ-
დეთ უკან. ამისათვის შედით მთავარ მენიუში, აირჩიეთ 
Option>Anotation Mode ბრძანება.  

თქვენ მიერ ტრანსკრიბირებული ტექსტი გამოჩნდება ვი-
დეოს შესაბამის სეგმენტზე.    
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სურ.37. ELAN-ში ფრაზების ტრანსკრიბირების შედეგი 

თუ გინდათ რამდენიმე ველში დაამატოთ ტექსტი, მაშინ 
გამოიყენეთ ღილაკი configure, რის შემდეგაც გამოჩნდება ფანჯარა 
transcriptiom mode settings. + და - ღილაკებით შესაძლებელია დაა-
მატოთ ან წაშალოთ ველები. შემდეგ Apply ღილაკით ადასტუ-
რებთ მიღებულ შედეგს. 

 
სურ.38. ELAN-ში ფრაზების ტრანსკრიბირების რეჟიმში ველების მართვის 

ფანჯარა  



38 
 

 
ბრძანებების სწრაფი წვდომის ღილაკების სიის ნახვა შესაძ-

ლებელია მთავარ მენიუში Edit>Preferences>Edit shortcuts ბრძანე-
ბის გამოძახების შემდეგ. 

 

 
სურ.39. ELAN-ში ბრძანებებთან სწრაფი წვდომის ღილაკების  

კომბინაციათა სია  
 

იმისათვის, რომ  შესაძლებელი იყოს ძირითად ფანჯარაში  ყვე-
ლა ველში ჩაიწეროს ტექსტი, მთავარ მენიუში აირჩიეთ შემდეგი 
ბრძანება: Tier>Create Annotation on dependent Tiers. გამონათებულ ფან-
ჯარაში დააჭირეთ ღილაკს next. მონიშნეთ ყველა ველი და დაადას-
ტურეთ ღილაკით Finish. 
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სურ.40. ELAN-ში ველების რედაქტირების რეჟიმის არჩევა  

ტოკენების ველის ავტომატურად გასააქტიურებლად მთა-
ვარ მენიუში ირჩევთ: Tier>Tokenize Tier ბრძანებას, გამონათებულ 
ფანჯარაში შეარჩევთ შესაბამის ველებს (რომლებიც უკვე შექმნი-
ლი გაქვთ) და დააჭერთ ღილაკს start. 

 

 
სურ.41. ELAN-ში ტოკენების ველის ავტომატურად გააქტიურების ფანჯარა 
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თუ ბევრი ვიდეოფაილის სეგმენტირება გჭირდებათ და 
ყველგან ერთი და იგივე ველები (tier)  და ტიპები (type) უნდა 
გამოიყენოთ, ამისთვის შესაძლებელია ერთხელ მომზადებული 
ფაილი შეინახოთ, როგორც შაბლონი (template).  

შაბლონის (template)  შესაქმნელად პროექტში, რომელშიც 
ველების და ტიპების ჩამონათვალი უკვე არის  შექმნილი, შედი-
ხართ მთავარ მენიუში, ირჩევთ: File>Save as Template ბრძანებას,  

 

 
სურ.42. ELAN-ში შაბლონის შენახვის ბრძანების გამოძახება 

 
რის შემდეგაც ეკრანზე გამოდის ფაილის შენახვის სტანდარტუ-
ლი ფანჯარა, რომლის მეშვეობითაც ინახავთ პროექტის შაბლონს. 

თქვენ მიერ შექმნილი შაბლონური ფაილი შეგიძლიათ 
გამოიყენოთ ყოველი ახალი ვიდეოფაილის სეგმენტირებისა და 
ტრანსკრიბირებისთვის.  

ამისათვის ქმნით ახალ პროექტს File > new. ჯერ ირჩევთ ვი-
დეოფაილს (media ღილაკის საშუალებით), რომლის ტრანსკრიბი-
რებაც გჭირდებათ და ღილაკით select გადაგაქვთ მეორე ფანჯარა-
ში, შემდგომ იქვე ირჩევთ შაბლონურ ფაილს (template ღილაკის 
საშუალებით).  
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სურ. 43. ELAN-ში პროექტის შექმნა წინასწარ შექმნილი შაბლონის  

მიხედვით 

 
მას შემდეგ, რაც უკვე შერჩეული გაქვთ ვიდეო და შაბლო-

ნური ფაილი, აჭერთ ღილაკს OK. ახალი ფაილი გაიხსნება, სადაც 
უკვე იქნება ველებისა (tier) და ტიპების (type) ჩამონათვალი.  

ასე შეგიძლიათ გამოიყენოთ უკვე შექმნილი ველები ყოვე-
ლი ახალი ვიდეოფაილის ტრანსკრიბირებისთვის, თუ ერთი და 
იგივე ველები გჭირდებათ. 

ამგვარი ფაილი შემდგომი დამუშავების მიზნით უნდა 
გადაიტანოთ ანოტირების სპეციალურ პროგრამაში FLEx-ი. 
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33.3. ტექსტის გლოსირებისა და ანოტირების                   
ინსტრუმენტი  FLEx-ი 

(Fieldworks Language Explorer) 
 

საველე ექსპედიციაში მოპოვებული მასალების შემდგომი 
დამუშავებისათვის თანამედროვე დოკულინგვისტიკაში გამოი-
ყენება ენობრივი მასალების ელექტრონული დამუშავებისათვის 
საგანგებოდ შექმნილი პროგრამა FLEx-ი (Fieldworks Language 

Explorer). წინამდებარე თავში ჩვენ აღვწერთ ამ პროგრამის სტრუქ-
ტურას, მისი გამოყენების წესებს და შევეცდებით, დავასაბუთოთ 
მისი გამოყენების  უპირატესობა სხვა ამ ტიპის პროგრამებთან შე-
დარებით.  

საველე ექსპედიციებში მოპოვებული ენობრივი მასალების 
ელექტრონული დამუშავების პროგრამა FLEx-ი შექმნილია SIL 

International -ის მიერ. SIL International-ი ანუ ენების საერთაშორისო 
საზაფხულო ინსტიტუტი (Summer Institute of Linguistics) შეიქმნა 
1934 წელს და წარმოადგენს არაკომერციულ, არასამთავრობო ორ-
განიზაციას, რომლის მიზანია ენათმეცნიერების შემდგომი განვი-
თარება ამ დისციპლინის კვლევის ობიექტების, ენების რაოდენო-
ბის გაზრდის ხარჯზე. როგორც ცნობილია, ენათმეცნიერების, 
როგორც სამეცნიერო დისციპლინის, განვითარება ძირითადად 
„დიდი ენების“ კვლევის გზით წარიმართა. როგორც საზოგადოე-
ბის, ისე მკვლევართა ფართო წრისათვის უცნობი  ენები კვლევის 
მიღმა დარჩა. შესაბამისად, ის ენობრივი ფორმები და კატეგორიე-
ბი, რომლებიც შეუსწავლელ ენებში მოიპოვება, ლინგვისტური 
ანალიზის საგანი არ გამხდარა და შესაბამისად, ზოგადი ლინ-
გვისტური ცოდნაც ენის, როგორც სისტემის, შესახებ არასრული 
აღმოჩნდა. მხოლოდ XX საუკუნის დასაწყისში ჩნდება ინტერესი 
„უცნობი“, განსაკუთრებით კი საფრთხეში მყოფი ენების მიმართ, 
თუმცა აქვე უნდა აღინიშნოს, რომ ისეთი ცნებები, როგორებიცაა 
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„საფრთხეში მყოფი ენები“ და კრიტერიუმები, რომლებიც ენის სა-
ფრთხეში ყოფნის დონეს განსაზღვრავს, მოგვიანებით შემუშავდა 
და მიზნობრივი კვლევის საგნად მხოლოდ გასული საუკუნის 80-
იანი წლების შემდეგ იქცა (იხ. იუნესკოს მიერ შემუშავებული „სა-
ფრთხეში მყოფი ენების რეგისტრი“, ფოლკსვაგენის ფონდის სა-
განგებო პროგრამა „საფრთხეში მყოფი ენების ელექტრონული 
დოკუმენტაცია“ და ა.შ.).  

SIL International-ის დაარსების უპირველესი მიზანი იყო უც-
ნობი, მათ შორის, საფრთხეში მყოფი ენების აღმოჩენა, შესწავლა 
და მათი, როგორც კულტურის არსებითი კომპონენტის, დოკუ-
მენტირება, თუმცა შემდგომში ამ ორგანიზაციის აქტივობა შინა-
არსობრივად გაფართოვდა და შეიქმნა საგანგებო მიმართულება, 
რომელიც მიზნად ისახავდა საფრთხეში მყოფი ენების არა მხო-
ლოდ „აღმოჩენას“ და დოკუმენტირებას, არამედ წერა-კითხვის 
გავრცელებას ამ ენათა მატარებელ შესაბამის სოციუმში და ენობ-
რივი უმცირესობებისათვის დახმარების აღმოჩენას, რათა არ გა-
მქრალიყო მათი მშობლიური ენა. ორგანიზაციის ერთ-ერთი მთა-
ვარი მიმართულება დღეს საგანგებო პროგრამების შემუშავება-
განხორციელებაა. იგი ხელს შეუწყობს ამ ენების შემდგომ ფუნ-
ქციონირებას. SIL International-ის ერთ-ერთ ძირითად დამსახურე-
ბად უნდა ჩაითვალოს ის, რომ მის მიერ შემუშავებული პროგრა-
მები  ხელს უწყობს ენის მდგრად განვითარებას. 

SIL International-ი, შეიძლება ითქვას, რელიგიური,  კერძოდ, 
ქრისტიანული  ორგანიზაციაა, ვინაიდან ის მჭიდროდ თანამ-
შრომლობს ბიბლიის გამავრცელებელ საერთაშორისო საზოგა-
დოებასთან Wycliff, რომელიც ცნობილი ინგლისელი ფილოსო-
ფოსის, თეოლოგისა და ეკლესიის რეფორმატორის - ჯონ ვიკლი-
ფის სახელს ატარებს. ეს არაკომერციული, ზეკონფესიური ევანგე-
ლიკური საზოგადოება მიზნად ისახავს ბიბლიის მსოფლიოს 
სხვადასხვა ენაზე, განსაკუთრებით კი უმცირესობების ენებზე  
თარგმნას და ამ გზით მის გლობალურ გავრცელებას. SIL-ი ასევე 
მჭიდროდ თანამშრომლობს  ეთნოლინგვისტურ საზოგადოებებსა 
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და მათ პარტნიორებთან. SIL International-ის მიერ შექმნილი რე-
სურსი „Ethnologue“, რომელიც 1951 წლიდან იქმნება, მოიცავს 
მსოფლიოს სხვადასხვა ენის დოკუმენტირების მასალებს. ამგვარი 
პარტნიორობის შედეგად შექმნილი რესურსები ინტერდისციპ-
ლინური კვლევის საუკეთესო საშუალებას წარმოადგენს, ვინაი-
დან იგი მოიცავს არა მხოლოდ ენობრივ მასალებს, არამედ წარმო-
აჩენს ენის გამოყენების სფეროებს და დინამიკას: იკვლევენ ენას 
მის ბუნებრივ გარემოში: ყოველდღიური ცხოვრების სხვადასხვა 
სფეროში, როგორებიცაა: სოციალური, კულტურული, პოლიტი-
კური, ეკონომიკური, სულიერი, რელიგიური და ა.შ. 

SIL International-ის ერთ-ერთ მნიშვნელოვან დამსახურებად 
უნდა ჩაითვალოს ენის ელექტრონული  დოკუმენტირების პროგ-
რამული უზრუნველყოფის განვითარება. აღნიშნული ორგანიზა-
ცია სისტემატურად ქმნის და განავითარებს საგანგებო პროგრა-
მულ ინსტრუმენტებს ენების თანამედროვე ტექნოლოგიების 
გამოყენებით დოკუმენტირებისთვის. მას წინ უძღოდა ორი პროგ-
რამული უზრუნველყოფა Shoebox-ი და Toolbox-ი, როგორც ენობ-
რივი რესურსების ელექტრონული დამუშავების პროგრამის უფ-
რო ადრეული ვერსიები და FLEx-ის წინამორბედები. Field 

Linguist's Toolbox-ი, რომელსაც ჩვეულებრივ „ინსტრუმენტთა 
ყუთს“ უწოდებენ, რამდენიმე ათეული წლის განმავლობაში ენობ-
რივი დოკუმენტირების ერთ-ერთი ყველაზე ხშირად გამოყენე-
ბული პაკეტი იყო. Shoebox-ი და Toolbox-ი მოგვიანებით SIL-მა  
შეცვალა უფრო ძლიერი პროგრამული პაკეტით - FLEx (Fieldworks 

Language Explorer), რომელშიც დაძლეულია ის ხარვეზები, რო-
მლებიც Shoebox-სა და Toolbox-ს ჰქონდა. 
 

33.3.1. რა არის FLEX-ი? 
FLEx-ი არის პროგრამა, რომელიც განკუთვნილია ენობრივ 

მონაცემთა ორგანიზებისა და ანალიზისათვის. FLEx-ი მომხმარე-
ბელს საშუალებას აძლევს, შექმნას ტექსტური კორპუსი, რომე-
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ლიც შეიცავს სიტყვათა სიას გრამატიკული ინდექსითა და გან-
მარტებებით. ტექსტებში თითეული სიტყვა ან მორფემა შეიძლება 
დაუკავშირდეს ლექსიკონს, რაც სისტემურობის თვალსაზრისით 
ეფექტურს ხდის ენობრივი მასალების ანალიზს. 

FLEx-ი მოიცავს ხუთ ძირითად ინსტრუმენტს, რომლებიც 
ერთი მხრივ ერთმანეთისაგან არის გამოყოფილი, თუმცა ერთობ-
ლივად ფუნქციონირებენ. თითეული ეს ინსტრუმენტი შედგება 
მრავალრიცხოვანი პარამეტრისა და მონაცემთა ველებისაგან, რო-
მელთა უმეტესი ნაწილი შეიძლება (და აუცილებელიცაა) მორგე-
ბული იყოს მოცემული ენის საჭიროებებზე. ინსტრუმენტებს შო-
რის გადართვა შე საძლებელია სპეციალური პანელის მეშვეობით, 
რომელიც განლაგებულია სამუშაო ფანჯრის მარცხენა ქვედა კუ-
თხეში (იხ. სურ. 44) 

  
1. ლექსიკონი; 
2. ტექსტი & სიტყვა;   
3. გრამატიკა; 
4. ჩანაწერების არეალი; 
5. სიები. 

 
სურ.44. FLEx-ში არსებული ინსტრუმენტების პანელი და მათი დასახელება 
 

განვიხილოთ თითეული ინსტრუმენტი ცალ-ცალკე. 
 

ა) ლექსიკონი 
 
ლექსიკონი, რომელიც FLEx-ის ერთ-ერთ ძირითად ინ-

სტრუმენტს წარმოადგენს, შედგება სიტყვა-ფორმის ჩამონათვა-
ლისაგან (რომელშიც შესაძლებელია გამოიყოს ფუძე, ძირი, მო-
რფემები  და ა.შ.). მას ასევე ახლავს გრამატიკული მახასიათებლე-
ბი (მაგ., არსებითი სახელი, ზმნა, ზედსართავი სახელი და ა.შ.). 
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სურ.45. FLEx-ში ინსტრუმენტი ლექსიკონის (Lexicon) სამუშაო არე 

 
ბბ) ტექსტი და სიტყვა 

 
აღნიშნული ინსტრუმენტი შეიცავს ტექსტებში მოცემული 

სიტყვების ჩამონათვალს. ტექსტი, როგორც წესი, დაყოფილია წი-
ნადადებებად. წინადადება ამ ინსტრუმენტში დაყოფილია სი-
ტყვებად.  

ტექსტი და სიტყვის (Texts &Words) ინსტრუმენტი სიტყვე-
ბის ანალიზის საშუალებას იძლევა. თუ მომხმარებელი გამოიყე-
ნებს თანდართულ ლექსიკონს, აქ მოქმედ პარსერს (Parser). ამ შე-
მთხვევაში სიტყვათა ლექსიკური ანალიზატორი), განახორციე-
ლებს ავტომატურ ანალიზს წინასწარ ჩადებული წესების საფუძ-
ველზე. დისკურსის ანალიზი აადვილებს ტექსტების ანალიზს. 
ლექსიკონში საანალიზო სიტყვის არარსებობის შემთხვევაში შე-
საძლებელია მანუალური  ანალიზი. გაანალიზებული სიტყვა შე-
იძლება დაემატოს ლექსიკონს, ხოლო პარატექსტის ანალიზი და 
მისი გამოყენება კიდევ უფრო დახვეწილს ხდის ავტომატურ ანა-
ლიზს დისკურსის ფარგლებში. კონკორდანსის, განსაკუთრებით 
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რთული კონკორდანსის, არსებობა დაგეხმარებათ კონტექსტური 
მნიშვნელობების დადგენაში (იხ. სურათი ქვემოთ). 

 

 

სურ.46. FLEx-ში ინსტრუმენტი ტექსტი და სიტყვა (Texts &Words)  
სამუშაო არე 

  
გ) გრამატიკა 

 
გრამატიკის ინსტრუმენტი შეიცავს მორფოლოგიური ანა-

ლიზის საშუალებებს და შესაძლებლობას გაძლევთ, განსა-
ზღვროთ წესები, რომლებიც დაგეხმარებათ, მართოთ პროექტის 
მონაცემები. გრამატიკის ინსტუმენტი ინახავს გრამატიკულ მონა-
ცემებს, რომლებიც მიემართება ლექსიკონს, საჭიროების შემთხვე-
ვაში რედაქტირებადია და თავის მხრივ გამოიყენება  პარსერებით. 



48 
 

 
სურ.47. FLEx-ში ინსტრუმენტი გრამატიკა (Grammar) სამუშაო არე  

 
დ) ჩანაწერების ინსტრუმენტი 

 
FLEx-ის ერთ-ერთ უმნიშვნელოვანეს ინსტრუმენტს წარმო-

ადგენს ჩანაწერების არეალი (Notebook), რომელიც მონაცემების 
ინტერდისციპლინური თვალსაზრისით მართვის საშუალებას იძ-
ლევა.  მაგალითად, გამოდგება ენისა და კულტურის სფეროში მუ-
შაობისთვის. ეს ინსტრუმენტი ხელს უწყობს თქვენი ველების შე-
სახებ დასკვნების დოკუმენტაციას, კატეგორიზაციას, მოძიებას, 
ანალიზსა და შეჯამებას. ჩანაწერების ინსტრუმენტის (Notebook) 
ტექსტური ველი ავტომატურად ხელმისაწვდომია ტექსტისა და 
სიტყვის (Text and words) ინსტრუმენტებიდან. 

 
5. სია 

ინსტრუმენტი სია (List)  შეიძლება თავად შექმნათ და შემ-
დეგ გამოიყენოთ თქვენი კონკრეტული პროექტის მოთხოვნების 
შესაბამისად.  
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33.3.2. მონაცემთა გადატანა ELAN-იდან FLEx-ში 
 

იმის გამო, რომ ELAN-ის სამუშაო ფაილები პირდაპირ არ 
იხსნება FLEx-ის მეშვეობით, აუცილებელია მონაცემთა ექსპორტი 
FLEx-ის ფორმატის ფაილში. 
ამისათვის საჭიროა: 

1. Elan-ის მთავარ მენიუში აირჩიეთ პუნქტი File> Export As.> 

Flex File (ჩვეულებრივ ის სიაში მეორე ადგილზეა);  
2. ეკრანზე გამონათებულ ფორმაში აირჩიეთ  Interlinial-title-

kat, რის შედეგად ფორმის ქვედა ნაწილში უნდა გამო-
ჩნდეს Elan-ში არსებული ყველა ველი (A B C). 

 
სურ.48. მონაცემთა ექსპორტი ELAN-იდან FLEx-ში   
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სურ.49. ELAN-იდან FLEx-ში მონაცემთა ექსპორტის პარამეტრების  
დალაგება 

 
3. იმ შემთხვევაში, თუ ყველაფერი სწორად არის შესრულე-

ბული (ანუ ჩანს ყველა ველი და ისინი მონიშნულია),    

 
 

სურ.50. ELAN-იდან FLEx-ში მონაცემთა ექსპორტის პარამეტრების 
დალაგება (გაგრძელება)  
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დააჭირეთ ღილაკს next სამჯერ, რის შედეგად მოხვდებით ექ-
სპორტირებული მონაცემების დამახსოვრების რეჟიმში. აქ უნდა 
მიუთითოთ სასურველი ფაილის სახელი.  

 
 

სურ.51. ELAN-იდან FLEx-ში მონაცემთა ექსპორტის ფაილის სახელისა  
და მისამართის შეყვანა 

 
იმისათვის, რომ შემდეგში არ გაჭირდეს ექსპორტირებული 

მონაცემების დაკავშირება საწყის პროექტთან, სასურველია ექ-
სპორტირებული მონაცემის ფაილი შეიცავდეს ორიგინალი პრო-
ექტის სახელს და აჭერთ ღილაკს Save. 
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სურ.52. ELAN-იდან FLEx-ში მონაცემთა ექსპორტის დასასრული  

 
და შემდეგ Finish-ს. ამგვარად იქმნება Flex-ის ფორმატის პროექ-
ტი. 
 

3.3.3. FLEx-ში მუშაობის პროცესის თანმიმდევრული          
აღწერა 
 

FLEx-ში მუშაობის დასაწყებად, უპირველეს ყოვლისა, უნ-
და შეიქმნას ახალი, თქვენი ინდივიდუალური პროექტი. ამისა-
თვის გამონათებულ საწყის მენიუში აირჩიეთ პუნქტი Create a new 
project...  
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სურ.53. ELAN-ის საწყისი ფანჯარა 
 

1. New FieldWorks Project-ის ფანჯარაში უნდა შეიტანოთ 
პროექტის სახელი  და განსაზღვროთ დამწერლობისა და ანალი-
ზის ენა. გაითვალისწინეთ, რომ შეგიძლიათ დატოვოთ ინგლისუ-
რი, როგორც ანალიზის ენა. შემდეგ დააჭირეთ ღილაკს OK. 

 
სურ.54. FLEx-ში ახალი პროექტის პარამეტრების ფანჯარა  



54 
 

 
2. შემდეგ ფანჯარაში უნდა აირჩიოთ  ანთროპოლოგიური 

კატეგორიები. აქ შეგიძლიათ დატოვოთ ყველაფერი ისე, 
როგორც არის და მხოლოდ დააჭიროთ OK- ს. 
 

 
 

სურ.55. FLEx-ში ახალი პროექტის ანთროპოლოგიური პარამეტრე-
ბის არჩევა  

 
აღნიშნული ოპერაციების განხორციელების შედეგად მონა-

ცემები მზად არის ELAN-იდან FLEx-ში გადასატანად. 
 

 
3.3.4. მონაცემთა იმპორტი ELAN-იდან FLEx-ში 

 
ELAN-იდან მონაცემთა იმპორტისათვის აუცილებელია ამ 

მონაცემთა დამახსოვრება FLEx-ის ფორმატში (იხ. გვ. 52). ELAN-
იდან ექსპორტირებული მონაცემების იმპორტის მიზნით დააჭი-
რეთ ღილაკს Texts &Words, რის შემდეგაც პროგრამის მთავარ მე-
ნიუში უნდა აირჩიოთ პუნქტი: File>Import>FLExText Interlinear. 
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სურ.56. FLEx-ში მონაცემთა იმპორტის ბრძანება  
  

გამოჩნდება ფაილის არჩევის ფორმა, სადაც უნდა შეიყვა-
ნოთ სასურველი ფაილის სახელი თუ ზუსტად იცით მისი სახე-
ლიცა და მისამართიც. წინააღმდეგ შემთხვევაში ისარგებლეთ ღი-
ლაკით Browse, რა დროსაც გამოჩნდება ფაილის გახსნის სტან-
დარტული ფანჯარა, სადაც შეგეძლებათ გადახვიდეთ სასურველ 
საქაღალდეში, აირჩიოთ საჭირო ფაილი და დააჭიროთ ღილაკს 
Open. 

 

 
სურ.57. FLEx-ში მონაცემთა იმპორტის ფაილის ამორჩევა  

 

იმ შემთხვევაში, თუ იმპორტირების დროს ქართულად შე-
სრულებული ტექსტი არ ჩანს ეკრანზე, მაშინ მთავარ მენიუში 
აირჩიეთ ბრძანება Format>Styles. 
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სურ.58. FLEx-ში ტექსტის სტილის შეცვლის ბრძანება   

 
გამონათებულ ფანჯარაში უნდა გადახვიდეთ ჩანართში 

Font-ი და აქ არსებული ჩანაწერის – Georgian გასწვრივ მოათავსოთ 
კურსორი. შემდეგ ფორმის ქვედა ნაწილში აირჩიეთ ფონტი 
Sylfaen-ი (სასურველი ატრიბუტებით) და დაეთანხმეთ. 

 

 
 

სურ.59. FLEx-ში ტექსტის სტილის არჩევის ფანჯარა 
 

ყურადსაღებია ის გარემოება, რომ FLEx-ის ერთ პროექტში 
შესაძლებელია (და რიგ შემთხვევაში აუცილებელიც) ELAN-ის 
რამდენიმე პროექტის აკუმულირება. ამ შემთხვევაში თითეულ 
მათგანში შემავალი ტექსტი (Baseline) საერთო პროექტში გამო-
ჩნდება როგორც ცალკეული ჩანართი, მაგრამ იმპორტირების 
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დროს ხშირად იკარგება მათი სახელები და ეს ჩანართები ეკრანზე 
ჩანს სახელების გარეშე. შესაბამისად, იმპორტირების შემდეგ აუ-
ცილებელია ტექსტის ზემოთ Title-ის ველში მიუთითოთ ის სახე-
ლი, რომლითაც გსურთ, რომ ტექსტი ჩანდეს პროექტში. 

   
6. ტექსტი გაიხსნება საგანგებო ფანჯარაში და ასე გამოიყურება: 
 

 
 

სურ.60. FLEx-ში მონაცემთა იმპორტის შედეგად მიღებული ჩანაწე-
რების სია და ტექსტის მაგალითი  

 
 Flex-ში შესაძლებელია იმპორტირებული ტექსტის ცალკე-

ული სიტყვის მორფოლოგიური ანალიზი. დააჭირეთ ღილაკს 
Analyze და interlinearise, სადაც მოცემულია საანალიზო სიტყვები. 
სიტყვის გრაფაში ჩამოშალეთ და დააჭირეთ Edit Morphem Brakes.  
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სურ.61. FLEx-ში მონაცემთა მორფოლოგიური ანალიზის სამუშაო არე  

დაწკაპების შემდეგ გამოანათებს ფანჯარა, სადაც გამოყო-
ფილ ველში შეძლებთ მის დაშლას მორფემებად მითითებული 
პრინციპების მიხედვით (ფუძე, ძირი, აფიქსები...) 
 

 
სურ.62. FLEx-ში სიტყვაფორმის სეგმენტირება 
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კონკრეტულ შემთხვევაში მორფემა -ებ (მარნ-ებ-ი-ო) არის 

სუფიქსი, შესაბამისად დამორფემებისათვის უნდა გამოიყენოთ 
ნიშანი [-] მხოლოდ მორფემის წინ. შესაბამისად, შესაძლებელი 
ხდება გრამატიკულ ინდექსთა განმარტებები. 
 

 
სურ.63. FLEx-ში სიტყვების მორფემებად დაშლის მაგალითი  

ანალიზის ვარიანტები: 
სიტყვა „პატარა“ ზედსართავი სახელია. ამ შემთხვევაში 

თქვენ არ გჭირდებათ დამორფემების  რედაქტირება.  
  თუ სიტყვა არის ვარიანტი ან სხვა ჩანაწერის ალომორფი, 

რომელიც თქვენ უკვე შექმენით, შეგიძლიათ აირჩიოთ ვარიანტი 
Variant ან Allomorph.: 
 

 
სურ.64. FLEx-ში ცალკეული სიტყვის ანალიზის ვარიანტები 
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შესაძლებელია Morpheme Type-ში შესვლისას ჩამოიშალოს 

სიტყვის მორფემებად დაშლის ყველა შესაძლებლობა, შესაბამი-
სად ხერხდება ცალკეული მორფემის ტიპის დადასტურებაც. 
 

 
 

სურ.65. FLEx-ში ცალკეული სიტყვის ანალიზის  
ვარიანტები (გაგრძელება)  

 
ამავე ფანჯარაში თუკი გახსნით Category-ს,  გამოანათებს 

დამატებითი ფანჯარა მეტყველების ნაწილთა ჩამონათვალით. 
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სურ.66. FLEx-ში ცალკეული სიტყვის ანალიზის ვარიანტები (გაგრძელება) 
 

შესაბამისი კატეგორიის შერჩევის შემდეგ აჭერთ ღილაკს 
Create, რის შემდეგაც შესაძლებელია თითეული დამოუკიდებე-
ლი თუ დამხმარე მეტყველების ნაწილის კვალიფიკაცია. POS (Part 

of speech - მეტყველების ნაწილთა) ანოტაცია ლინგვისტური ანო-
ტაციის ყველაზე გავრცელებული ფორმაა, რომლის დროსაც ყვე-
ლა სიტყვაფორმას მეტყველების ნაწილის აღმნიშვნელი თეგი 
ენიჭება. 



62 
 

 
სურ.67. FLEx-ში ცალკეული სიტყვის ანალიზის ვარიანტები (გაგრძელება) 

მნიშვნელოვანია, რომ დამორფემების შემდეგ ცალკეულს 
ავტომატურად ენიჭება სახელები. 

 
სურ.68. FLEx-ში ცალკეული სიტყვის ანალიზის ვარიანტები (გაგრძელება) 
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  აღნიშნულ პროგრამაში მუშაობისას შესაძლებელია, რიგ 
სირთულეს წააწყდეთ. მაგ: ქვემოთ მოყვანილ შემთხვევაში სუ-
ფიქსი --ს პროგრამამ დაადასტურა, როგორც მიცემითი ბრუნვის 
ნიშანი. 
 

 
 

ამ შემთხვევაში შესაძლებელია მორფემის ნაწილში შესვლა 
და შესაბამისი ველის დაწკაპება დასაკორექტირებლად.  
 

 
სურ.69. FLEx-ში ცალკეული სიტყვის ანალიზის ვარიანტები (გაგრძელება) 

 
ამგვარად დამუშავებული ელექტრონული მონაცემები 

მზად არის  FLEx-იდან ELAN-ში საექსპორტოდ.  
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33.3.5. მონაცემთა ექსპორტი FLEx-იდან ELAN-ში 
 

Texts and Words-ის ინსტრუმენტიდან მთავარ მენიუში აირ-
ჩიეთ პუნქტი File>Export Interlinial-ი  

 

 
სურ.70. FLEx-იდან მონაცემთა ექსპორტი ELAN-ში 

 
ეკრანზე გამოჩნდება ფანჯარა, სადაც ჩამოთვლილია მონა-

ცემთა ექსპორტირების ყველა შესაძლო ვარიანტი. ELAN-ში ექ-
სპორტირებისათვის აირჩიეთ ამ სიის პირველი პუნქტი ELAN, 
SayMore, FLEx.    
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სურ.71. FLEx-იდან მონაცემთა ექსპორტის ფორმატის არჩევა 
 

დააჭირეთ ღილაკს Export, რის შედეგადაც ეკრანზე გამო-
ჩნდება ფორმა გახსნილ პროექტში არსებული ტექსტური ჩანაწე-
რების სიით.   

 

 
 

სურ.72. FLEx-იდან მონაცემთა ექსპორტის არჩევა 
 

მონიშნეთ ის ჩანაწერი, რომლის ექსპორტირებასაც აპირებთ 
და დაეთანხმეთ (დააჭირეთ ღილაკს OK). ეკრანზე გამოჩნდება 
ფაილის დამახსოვრების სტანდარტული ფანჯარა, სადაც უნდა 
აირჩიოთ ის საქაღალდე, რომელშიც აპირებთ ექსპორტირებული 
მონაცემების შენახვას და შეიყვანეთ ფაილის სახელი. 
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სურ.73. FLEx-იდან მონაცემთა ექსპორტის ფაილის დამახსოვრება 
 

შემდეგ დააჭირეთ ღილაკს Save. 
სასურველია, რომ ექსპორტირებული მონაცემები მოთავ-

სდეს იმავე საქაღალდეში, სადაც არის ტექსტის შესაბამისი მედი-
აფაილები (ვიდეო ან აუდიო) და ფაილის სახელი უნდა იყოს ამ 
მონაცემების შესაბამისი. 

 
33.3.6. მონაცემთა იმპორტი FLEx-იდან ELAN-ში 

 
FLEx-იდან ექსპორტირებული მონაცემების ELAN-ში იმ-

პორტირებისათვის საჭიროა გახსნათ შესაბამისი პროექტი ELAN-

ში და მთავარ მენიუში აირჩიოთ: File>Import>FLEx file…  
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სურ.74. ELAN-ში მონაცემთა იმპორტის ბრძანება 
 

ეკრანზე გაიხსნება ფანჯარა (ფორმა), სადაც უნდა მონიშ-
ნოთ ყველა პუნქტი (ფორმაზე დასაფიქსირებელი პარამეტრების 
სასურველი ვარიანტი იხ. სურათზე).    
 

 
სურ.75. ELAN-ში მონაცემთა იმპორტის პარამეტრების ფანჯარა 



68 
 

 
აირჩიეთ FLEx-იდან ექსპორტირებული მონაცემების ფაი-

ლი. ამისათვის დააჭირეთ FLEx file-ის გასწვრივ მოთავსებულ ღი-
ლაკს, რის შედეგად გაიხსნება ფაილის გახსნის სტანდარტული 
ფანჯარა და აირჩიეთ თქვენთვის სასურველი ფაილი. 

 
სურ.76. ELAN-ში მონაცემთა იმპორტის ფაილის არჩევის ფანჯარა 

დააჭირეთ ღილაკს Select. ELAN-ის ახალ ფანჯარაში გაიხსნე-
ბა იმპორტირებული მონაცემები შესაბამისი მედიაფაილით და 
FLEx-იდან ექსპორტირებული, შრეებად დაშლილი მონაცემებით. 

 
სურ.77. ELAN-ში მონაცემთა იმპორტის შედეგი 
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საველე ექსპედიციის პროცესში მოპოვებული რესურსების 
ამგვარი დამუშავება და ზემოთ აღწერილი პროგრამული 
საშუალებებისა და ინსტრუმენტების გამოყენების შედეგად 
მიღებული მასალა მზად არის ბათუმის ლინგვოკულტურო-
ლოგიურ დიგიტალურ არქივში განსათავსებლად.   

 



gamomcemloba `̀universali~ 

Tbilisi, 0186, a. politkovskaias #4. : 5(99) 33 52 02, 5(99) 17 22 30 
E-mail: universal505@ymail.com; gamomcemlobauniversali@gmail.com 



მანანა თანდაშვილი, რამაზ ხალვაში, 
რუსუდან პაპიაშვილი, მზია ხახუტაიშვილი, 

გრიგოლ კახიანი, ნანა ცეცხლაძე

ენისა და კულტურის

ელექტრონული დოკუმენტირების

თანამედროვე ინსტრუმენტები

მეგზური

ISBN 978-994-26-766-6

მანანა თანდაშვილი, რამაზ ხალვაში, 
რუსუდან პაპიაშვილი, მზია ხახუტაიშვილი, 

გრიგოლ კახიანი, ნანა ცეცხლაძე

ენისა და კულტურის

ელექტრონული დოკუმენტირების

თანამედროვე ინსტრუმენტები

მეგზური

ISBN 978-994-26-766-6




